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1.0 WHAT’S IN YOUR KIT?
FROM THE MAKERMADE LEARNING LIBRARY

THIS WORK IS LICENSED UNDER THE CREATIVE COMMONS ATTRIBUTION-SHAREALIKE 4.0 INTERNATIONAL LICENSE.
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HARDWARE BAGS

Attaches chains to frame

Multiple uses

Attaches carriages to ring

Cords, hardware for attaching 
to frame

Fastens motor to mounts

Fastens L-brackets to ring, 
and to sled

Holds bricks in place on sled

Attaches Arduino to frame

Attaches Z axis to router 
and sled

BAG #1

BAG #4

BAG #7

BAG #2

BAG #5

BAG #8

BAG #3

BAG #6

BAG Z



1.1 BUILDING THE FRAME

TOOLS NEEDED:
Saw
Power Drill
Screwdrivers
Safety goggles

BUILD TIME:
About 5 hours, plus
glue drying time

COST:
Approximately $90

CUT LIST:
2x4s
(1)120”
(1)  88”
(2) 82”
(2) 79”
(2) 60”

(2) 34”
(2) 30”
(2) 28”
(2)   7”
(4)3.5”

MATERIALS LIST:
(7) 10’ long 2x4s
(1) 8’ long 2x4
(1)  6’ long 2x4
(1) 4X8 sheet .75” plywood
(75-100) 2.25” wood screws
Wood glue
Hardware & parts from kit

Note: Lumber dimensions are not critical, if 2x4s are not available in your area the local 
equivalent will work. When cutting, try to keep the ends as square as possible, but small 
errors in the lengths of any of the parts will not affect accuracy of the machine.

DESIGN BY THE MASLOW COMMUNITY, PARTICULARLY USERS DLANG AND MADGRIZZLE

Precision Level

Difficulty Level

THIS WORK IS LICENSED UNDER THE CREATIVE COMMONS ATTRIBUTION-SHAREALIKE 4.0 INTERNATIONAL LICENSE.

BEFORE BEGINNING
Acquaint yourself with 
standard practices for 
workshop safety.
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STEP 1: BUY MATERIALS
2X4 (or equivalent lumber)

6'

10'

10'

10'

10'

10'

10'

8'

PLYWOOD

PRO TIP:
Label the parts as you 
cut them, you’ll be glad 
you did.
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STEP 2: CUT OUT PIECES AS SHOWN
2X4 (or equivalent lumber)

120” TOP BEAM

88” REAR CROSSMEMBER

34” VERTICAL

34” VERTICAL

30” KICKER

30” KICKER

28” DIAGONAL 28” DIAGONAL

82” FRONT CROSSMEMBER: LOWER

82” FRONT CROSSMEMBER: UPPER

79” FRONT LEG

79” FRONT LEG

60” BACK LEG 60” BACK LEG

3.5” SPACER

3.5” SPACER

3.5” SPACER

3.5” SPACER

7” BEAM

7” BEAM

PLYWOOD
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STEP 3/4A ATTACH KICKERS TO FRONT LEGS
•	Kickers at 90° angle to front legs
•	Kickers 11.5” from bottom of front legs, and 
overhanging by 1.75”

•	Screw through top of kickers into front legs
•	Screw through top of kickers into spacers
•	Flip each assembly over for next step

STEP 3/4C POSITION BACK LEGS
•	Rotate back legs out to end of kickers
•	Screw bottom of back legs to kickers
•	Add more screws to top of back legs

STEP 3/4B ADD BACK LEGS
•	Place back legs on top of front legs, 
aligning bottom ends

•	Mark center of back legs 1” from top end
•	Screw through top center of back legs 
into front legs at marked spot

•	Only 1 screw per leg, NO GLUE

Next steps are most easily done 
with front legs horizontal to floor, 
as shown. Prop with scraps to keep 
things level.

LEGS ARE NOW COMPLETE!
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FIGURE 1

FIGURE 2
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FIGURE 4

FRONT LEG
FRONT 
CROSSMEMBER
UPPER 82”

VERTICALS 34”
Just use to measure, DO NOT ATTACH!
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FIGURE 3

FRONT LEG

VERTICALS 34”

FRONT 
CROSSMEMBER
UPPER

FRONT 
CROSSMEMBER
LOWER

DIAGONAL 28”DIAGONAL 28”

VERTICAL

FIGURE 5

VERTICAL

CROSSMEMBER

STEP 5A ATTACH LOWER FRONT CROSSMEMBER
•	Rest lower front crossmember on kickers
•	Screw from top of crossmember into each 
kicker- see Figure 1

•	Screw from side of each front leg into 
crossmember- see Figure 2

STEP 5C ATTACH UPPER FRONT CROSSMEMBER
•	Rest upper front crossmember on spacers
•	Screw through sides of front legs into 
crossmember

STEP 5B ADD SPACERS
•	Use verticals to measure placement of 
spacers on inside of front legs

•	DO NOT ATTACH VERTICALS IN THIS STEP
•	Screw through spacers into front legs

STEP 6 ATTACH VERTICALS
•	Use diagonals to place verticals
•	DO NOT ATTACH DIAGONALS IN THIS STEP
•	Screw through top crossmember into verticals
•	Screw through bottom crossmember into 
verticals

View from above, front 
legs horizontal to floor, 
back legs sticking up
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STEP 7 ATTACH DIAGONAL BRACING
•	Rest diagonals with one end on front leg, 
one leg on upper crossmember

•	Screw diagonals in place on each end
•	Placement of diagonals need not be exact

STEP 9 ATTACH SIDE BEAMS
•	Beams were placed on cut list to have 
one factory end, this end should face out 
so top beam has a flat surface to rest on

•	Place beams at 90° angles to each front leg
•	Screw through beams into front legs

STEP 8 ATTACH REAR CROSSMEMBER
•	Rest rear crossmember on top of kickers 
where they protrude from back legs

•	Screw through rear crossmember into 
back legs

ALMOST FINISHED!
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TOP BEAM 120”

TOP BEAM

4’x8’ PLYWOOD SHEET

STEP 10 ATTACH TOP BEAM
•	Center top beam across front
•	Screw through top beam into 7” beams 
on each side

STEP 11 STAND UP FRAME & ATTACH PLYWOOD
•	Rest plywood on kickers
•	Attach with screws through front of 
plywood into each front leg

You now have a complete frame!
NEXT STEP: ATTACHING THE ELECTRONICS
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TOOLS NEEDED:
Power Drill
Screwdrivers
Safety goggles
Computer or tablet
Internet connection

BUILD TIME:
About 1 hour

MATERIALS LIST:
Part #1 AC Power Cable
Part #2 Arduino with Heat Shield
Part #4 DC Power Supply
Part #9 USB Cable
Part #10 Flash Drive (optional)

Part #11 X and Y Motor Cables
Part #12 X and Y Motor Mounts
Part #13 X and Y Motors
Hardware Bag #5
Hardware Bag #6

Before adding the electronics to the frame, there’s a bit of setup- downloading and 
adding programs and information, that needs to be done

1.2: ADDING THE ELECTRONICS
DESIGN BY THE MASLOW COMMUNITY, PARTICULARLY USERS DLANG AND MADGRIZZLE

Precision Level

Difficulty Level



STEP 1: CONNECT THE MOTORS
PART #2 Arduino with Heat Shield
PART #11 X & Y Motor Cables
PART #13 X & Y Motors
•	X and Y motor cables, as well as motors, 
are interchangeable at this point

•	Insert one end of a cable into each motor
•	Insert other ends into to Ports 1 and 3 on 
Arduino with yellow wire at bottom as shown

•	Port 3 controls left motor Port 1 controls 
right motor as viewed when facing the 
Maslow CNC. 

STEP 2: CONNECT THE POWER SUPPLY
PART #1 AC Power Cable
PART #3 DC Power Supply
•	Plug DC power supply into shield
•	Arduino also has a power supply port, 
plugging power supply into it will not 
damage it, but will not provide power to 
motors

•	Connect power cable to DC Power Supply
•	Plug power cable into surge protected 
electrical outlet

STEP 3: CONNECT THE USB CABLE
PART #9 USB Cable
Computer or tablet
•	Plug USB cord into Arduino 
•	Plug other end into your computer
•	USB light will come on to indicate that 
board is connected and receiving power 
from your computer

X

X
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STEP 4: DOWNLOAD THE ARDUINO IDE
Internet connection
Computer or tablet
•	In your browser, navigate to  
https://www.arduino.cc/en/Main/Software

•	Download latest version of Arduino IDE
•	Note: Some users have reported problems 
with “Windows App” version

•	Open zip folder
•	Install program on your computer
•	Open program

STEP 6: SET UP FIRMWARE
•	Click File -> Open 
•	Select cncctrlv1.ino
•	Click Tools -> Board
•	Select Arduino/Genuino Mega or Mega 2560
•	Click Tools -> Port -> Your Port
•	Select port- on Windows, COM3, on Mac 
and Linux computers dev/tty/

•	If unsure, disconnect USB cable from 
Arduino, check which option disappears.

STEP 5: DOWNLOAD MASLOW FIRMWARE
•	In your browser, navigate to  
http://github.com/MaslowCNC/Firmware/releases/

•	Download latest version of firmware
•	Open zip folder
•	Install program on your computer

STEP 7: ADD FIRMWARE TO ARDUINO
•	Click upload button in top left corner
•	This uploads firmware to Arduino
•	Linux users: if getting timeout or 
permissions errors, try adding username to 
dialout group then logging out and back in

•	When upload finishes, close Arduino IDE

STEP 8: INSTALL GROUND CONTROL
•	In your browser, navigate to  
https://github.com/MaslowCNC/
GroundControl/releases

•	Download latest version of Ground Control
WINDOWS USERS 
•	Open zip folder
•	Click Launch Ground Control” shortcut
MAC USERS
•	Install Ground Control by moving it into 
your applications folder

•	Click icon in applications folder
•	Select “Open”
Linux and Raspberry Pi users:
•	Reference instructions online at http://
maslowcommunitygarden.org/
GroundControl.html?instructions=true

STEP 9: CONNECT GROUND CONTROL TO 
MASLOW
•	In Ground Control, click ACTIONS on top left
•	Click PORTS, a list of ports will appear
•	Select same  port you used in Step 6
•	Click CONNECT

THAT PART’S DONE! YOU’RE NOW READY TO 
INSTALL THE ELECTRONICS ON THE FRAME. 
BEFORE PROCEEDING DISCONNECT POWER 
CABLES, USB CABLES, AND MOTOR CABLES.

NOTE: Ground Control is the program 
which runs on your computer and lets 
you control your Maslow CNC. It ’s free 
and is updated often.
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FRONT VIEW SIDE VIEW

STEPS 12-14 TAKE PLACE ON THE TOP BEAM OF THE FRAME, REPEATED ON EACH END

FRONT VIEW
STEP 12: INSTALL MOTOR MOUNTS ON FRAME 
BAG #4 (8) wood screws
PART #12 X/Y Motor Mounts
•	Position motor mounts on beam flush with 
front and side edges

•	Using two screws per slot on base of each 
motor mount, fasten motor mounts to 
beam with wood screws

STEP 13: ATTACH MOTORS TO MOUNTS
BAG #5 (8) small screws, (8) lock washers
PART#13 X/Y Motors
•	Place one motor in each bracket
•	Slide lock washers over screws
•	Fasten screws through front of motor 
mount into aligned holes in motor

STEP 14: INSTALL SPROCKETS ON MOTOR SHAFTS
BAG#1 (2) sprockets, (2) set screws
Allen wrench
•	Insert set screw in hole on side of sprocket
•	Screw in slightly with allen wrench
•	Place sprocket over motor shaft
•	Tighten set screw with allen wrench

ATTACHING THE ELECTRONICS PG. 4LAST UPDATE 06.01.19



STEP 16 RECONNECT ELECTRONICS
PARTS #1-2 Power Cable, Power Supply
PART #9 USB Cable 
PART #11 X/Y Motor Cables
•	Attach Arduino to motors with cables
•	Connect power supply to Arduino
•	Connect USB cord to Arduino
•	For more details review electronics 
setup guide

USB CABLE
POWER CABLE

BACK OF FRAME

ARDUINO MOTOR & SHIELD

STEP 15 ATTACH THE ARDUINO
BAG #6 screws, standoffs
PART #2 Arduino 
•	Gently remove shield from Arduino
•	Position Arduino in center of plywood
•	Insert screws through holes
•	Slide standoffs over screws
•	Screw into plywood
•	Re-attach shield

STEPS 15-16 TAKE PLACE ON THE BACK OF THE FRAME

ATTACHING THE ELECTRONICS PG. 5LAST UPDATE 06.01.19

NEXT STEP: BUILDING THE TEMPORARY SLED



1.3 BUILDING THE TEMPORARY SLED

TOOLS NEEDED:
Router, .25” router bit
Handsaw or Circular Saw
Phillip’s Head Screwdriver
Power Drill, .25” & .5” drill bits
Socket Wrench, various sizes

5/16 Allen Wrench
Pencil
Safety goggles
Clamps (optional)

CUT LIST:
(1)  18x18” square
(2) 1x5.5” rectangles**

MATERIALS LIST:
(1)  4x8 Plywood, .75” thick*
(2) Bricks**
(3) Size 10-32 Machine Screws
Part #5 Ring Bearings
Part #6 Ring Mount
Part #7 Ring Bracket Mounts
Part #8 Ring Carriage
Hardware Bags #3,6,7,8

*If you have scrap plywood on hand, it’s not neccesary to buy a whole sheet of plywood
**If using MakerMade metal brickholders bricks should be no more than 4.5” wide 

DESIGN BY THE MASLOW COMMUNITY, PARTICULARLY USERS DLANG AND MADGRIZZLE

THIS WORK IS LICENSED UNDER THE CREATIVE COMMONS ATTRIBUTION-NONCOMMERCIAL-NODERIVATIVES 4.0 INTERNATIONAL LICENSE.

Precision Level

Difficulty Level

SLED BASE

BRICK
HOLDERS

1X5.5”

18”

18”
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STEP 1 CUT OUT PLYWOOD PARTS
Saw, ruler
•	Mark dimensions of parts on plywood
•	Exactness is not critical for temporary sled
•	Using hand or circular saw, cut out parts

STEP 3 REMOVE ROUTER HANDLES, BASEPLATE
5/16 allen wrench, screwdriver
•	Remove cap on side of handle
•	Bolt inside hole may be unscrewed with a 
5/16 allen wrench

•	Turn router over so baseplate is up
•	Use Phillips-head screwdriver to remove 3 
machine screws from bottom of baseplate

•	Set router and baseplate aside

SLED BASE

BRICK
HOLDERS

1X5.5”

18”

18”

1.5” DIAMETER

NOTE: These steps are for the Rigid 
router, other routers may differ

CAP
BOLT

BEHIND CAP

STEP 2 CUT CENTER HOLE FOR BIT
Router, .25” router bit, pencil
•	Mark 1.5”x1.5” hole in center of sled
•	Use router to cut out hole, going down 
approx 1/10” per pass

TOP VIEW SIDE VIEW

L-Brackets

Ring Bracket

STEP 4 ATTACH L-BRACKETS TO RING
BAG #8 (6)nuts, (6)bolts, allen wrench
PARTS #6-7 Ring bracket, (3)L-brackets
•	Line up L-brackets as shown with 
rectangular brackets on ring

•	Insert bolts from inside of ring bracket out 
through L-brackets, two per bracket

•	Secure with nuts, using allen wrench to 
tighten
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Shoulder
bolt

Ring
bearing

Washer

Washer

Nut

TOP VIEW SIDE VIEW

STEP 6 MARK PLACEMENT OF COMPONENTS
Pencil
•	Place components on sled as shown above
•	Baseplate of router in center of sled
•	Ring assembly centered around baseplate
•	Bricks and holders in corners, exact 
placement not critical

•	Use pencil to mark 3 holes in baseplate
•	Mark placement of ring and brick holders
•	Mark .5” circle as shown, middle of sled, 
halfway between top edge and ring

•	If using Z-axis with temporary sled, leave 
room for that as marked above 

STEP 5 ATTACH CARRIAGES TO RING
BAG #7 (4) shoulder bolts, (4) nuts, 
(8) washers, allen wrench
PART #2 Ring Bearings
PART #5 Carriage mounts
•	Place one carriage on either side of ring
•	Insert shoulder bolt up through bottom of 
carriage, slip one washer over bolt, then 
one ring bearing, then another washer

•	Push shoulder bolt through top of 
carriage, fasten with nut

•	Do this twice for each carriage
•	Use allen wrench to tighten bolts
•	Bearings should still rotate freely 

STEP 7 DRILL HOLES
Power drill, .25” and .5” drill bit, optional 
clamps
•	Place brick holders in marked spots, clamp 
into place (optional but helpful)

•	Mark a spot on each end of holder just 
outside of where the brick will be

•	Drill through holders and sled with .25” bit
•	Drill 3 holes where marked for router with 
.25” bit

•	Drill top hole with .5” bit
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STEP 9 ATTACH BRICKS TO SLED
Bag #3 Nuts, bolts
(2) brick holders
•	Insert bolts  through pre-drilled holes from 
bottom of sled through to the top

•	Place bricks between bolts
•	Place wooden brick retainers over bolts
•	Secure with nuts

STEP 10 ATTACH RING TO SLED
BAG #8 (18) small screws
•	Place ring on sled centered around router
•	Each L-bracket has six small holes, insert a 
small screw through each hole

•	Fasten with Phillips-head screwdriver

STEP 8 ATTACH ROUTER, TO SLED
(3) 10-32 machine screws
•	Insert screws through pre-drilled holes 
from bottom of sled into router

•	Tighten with Phillips-head screwdriver

TOP VIEW SIDE VIEW

TOP VIEW SIDE VIEW

TOP VIEW SIDE VIEW

NEXT STEP: INSTALLING THE Z-AXIS
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TERMS OF USE
This work is licensed under the 

CREATIVE COMMONS 
Attribution-NonCommercial-NoDerivatives 

4.0 International License

To view a copy of this license
visit http://creativecommons.org/licenses/by-nc-nd/4.0/ 

or send a letter to 
Creative Commons

PO Box 1866
Mountain View, CA 94042

YOU ARE FREE TO:
Share — copy and redistribute the material in any medium or format
The licensor cannot revoke these freedoms as long as you follow the license terms.

UNDER THE FOLLOWING TERMS:
Attribution — You must give appropriate credit, provide a link to the license, and 
indicate if changes were made. You may do so in any reasonable manner, but not in 
any way that suggests the licensor endorses you or your use.

NonCommercial — You may not use the material for commercial purposes.

NoDerivatives — If you remix, transform, or build upon the material, you may not 
distribute the modified material.

No additional restrictions — You may not apply legal terms or technological measures 
that legally restrict others from doing anything the license permits.

NOTICES:
You do not have to comply with the license for elements of the material in the public 
domain or where your use is permitted by an applicable exception or limitation.
No warranties are given. The license may not give you all of the permissions necessary 
for your intended use. For example, other rights such as publicity, privacy, or moral 
rights may limit how you use the material.



1.4 INSTALLING THE Z AXIS

TOOLS NEEDED:
Phillips-head screwdriver
T10 Torx Screwdriver
Safety goggles
Computer or tablet
Ground Control software (free)

MATERIALS LIST:
Part #14 Z Axis Motor
Part #15 Z Axis Motor Cable, 
Part #16 Z Axis Motor Mounts (2)
Hardware Bag Z
(2) Zipties

In manual use, your router has a knob/screw assembly that you turn in order to move 
the bit up and down. The Z axis is designed to replace that, saving you painstaking 
manual adjustments

These instructions are tailored to the Rigid router, if you have a different router, 
procedure may vary.

FROM THE MAKERMADE LEARNING LIBRARY, WITH THANKS TO THE MASLOW COMMUNITY

THIS WORK IS LICENSED UNDER THE CREATIVE COMMONS ATTRIBUTION-NONCOMMERCIAL-NODERIVATIVES 4.0 INTERNATIONAL LICENSE.
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STEP 3 ATTACH MOTOR TO MOUNTS
Bag Z (6) screws
Part #14 Z Axis Motor
Phillips-head screwdriver
•	Insert motor shaft through opening in 
bottom of L-bracket, from outside to inside

•	Align six small holes in bracket with 
matching holes in motor

•	Insert screws through holes
•	Tighten with Phillips-head screwdriver

STEP 2 JOIN MOTOR MOUNTS
Bag Z (4) bolts, (4) nuts
Bag #8 allen wrench
Part #16 Z Axis Motor Mounts (L-brackets)
•	Place l-brackets back to front as shown, 
with lengthwise slots lined up

•	Insert bolts through slots in both brackets
•	Hold bolts steady with allen wrench
•	Twist nuts over end of bolts to secure
•	Leave loose for later adjustment

STEP 1 REMOVE ROUTER ADJUSTMENT KNOB
T10 Torx Screwdriver
•	In the Rigid router, adjustment knob is 
dark gray, located on side of router

•	Insert T10 torx screwdriver into hole in top 
of adjustment knob

•	Loosen screw, remove knob
•	Save knob/screw in case you want to 
restore your router to manual control

NOTE: These steps are for the Rigid 
router, other routers may differ

T10 Torx 
Screwdriver

Machine
screws

Nuts

L-bracket

L-bracket

Z-Axis
Motor

L-brackets

Machine
screws
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STEP 5 ATTACH Z AXIS TO ROUTER AND SLED
Bag Z (6) wood screws
Bag #8 allen wrench
Phillips-head screwdriver
•	Slide free end of shaft coupler over 
adjustment screw on router

•	Use allen wrench to tighten 2 set screws to 
engage shaft coupler with router

•	If unable to reach a screw, leave it for later 
when the motor gets rotated

•	Adjust/slide L-brackets so bottom bracket 
rests on sled

•	Insert wood screws through small holes in 
bottom of L-bracket, screw into wood of 
sled 

STEP 6 ATTACH MOTOR CABLE
Bag #2 ziptie
Part #15 Z Axis Motor Cable
•	Insert one end of motor cable into end of 
Z Axis motor

•	Insert other end of cable into MP2 slot on 
Arduino

•	Use ziptie to secure cable to motor to 
provide relief from strain as sled moves

STEP 4 ATTACH THE SHAFT COUPLER
Bag Z shaft coupler
Bag #8 allen wrench
•	Shaft coupler has a larger hole on one end, 
a smaller hole on the other end

•	Slide end with smaller hole over motor shaft
•	Use allen wrench to tighten set screw 
nearest to motor

•	Leave other 2 set screws as is until Step 5

Wood
screws

Z-Axis
Motor
Cable Ziptie
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NEXT STEP: CALIBRATING YOUR MASLOW

STEP 7 ENABLE THE Z AXIS IN SETTINGS
Computer or tablet
Ground Control software
•	Open Ground Control
•	From main screen, click Settings
•	Scroll down to “z-axis installed”
•	Click switch to “on”
•	Directly below, check “z-axis pitch” setting
•	For Rigid router, setting should be 3.17
•	If using another router, check markings 
on knob removed from router. It should 
indicate the distance per-rotation, ie how 
far down the bit goes each time the handle 
is fully rotated

STEP 8 TIGHTEN SHAFT COUPLER
Bag #8 allen wrench
Computer or tablet
Ground Control software
•	If a set screw in the shaft coupler still 
needs to be tightened-

•	Rotate shaft coupler to access it using 
z-axis buttons in Ground Control

•	Tighten with allen wrench

STEP 9 LOOSEN ROUTER CLAMP
Phillip’s head screwdriver
•	On Rigid router, clamping mechanism 
must be adjusted to allow movement

•	Loosen screw on inside of clamp
•	Correct tension will allow router to move 
freely but not wiggle

Clamp
Screw
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TERMS OF USE
This work is licensed under the 

CREATIVE COMMONS 
Attribution-NonCommercial-NoDerivatives 

4.0 International License

To view a copy of this license
visit http://creativecommons.org/licenses/by-nc-nd/4.0/ 

or send a letter to 
Creative Commons

PO Box 1866
Mountain View, CA 94042

YOU ARE FREE TO:
Share — copy and redistribute the material in any medium or format
The licensor cannot revoke these freedoms as long as you follow the license terms.

UNDER THE FOLLOWING TERMS:
Attribution — You must give appropriate credit, provide a link to the license, and 
indicate if changes were made. You may do so in any reasonable manner, but not in 
any way that suggests the licensor endorses you or your use.

NonCommercial — You may not use the material for commercial purposes.

NoDerivatives — If you remix, transform, or build upon the material, you may not 
distribute the modified material.

No additional restrictions — You may not apply legal terms or technological measures 
that legally restrict others from doing anything the license permits.

NOTICES:
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rights may limit how you use the material.



1.5 CALIBRATING YOUR MASLOW

TOOLS NEEDED:
Maslow CNC
Router, .25” bit
Safety goggles
Protective gloves
Screwdrivers

MATERIALS LIST:
(1)  4x8 plywood, .75” thick*
(1) .5” carriage bolt

FROM THE MAKERMADE LEARNING LIBRARY, SPECIAL THANKS TO USER MADGRIZZLE

Power Drill, .5” bit
Hardware and components 
from kit
Computer or tablet
Ground Control software

THIS WORK IS LICENSED UNDER THE CREATIVE COMMONS ATTRIBUTION-NONCOMMERCIAL-NODERIVATIVES 4.0 INTERNATIONAL LICENSE.

Calibration is the step that sets your machine up so it will cut designs accurately. 
Calibration is of paramount importance and is probably the most difficult, and 
sometimes frustrating, part of owning a Maslow. Because every user sets up their own frame, 
there are a lot of varying factors that may cause temporary hiccups. If you do get frustrated, take 
a break and come back to it.

NOTE: SLED/ CHAINS SHOULD NOT BE ATTACHED TO FRAME AT THIS POINT!
If they were attached previously, remove them before proceeding 

Observe proper safety precautions, including wearing safety goggles and protective 
gloves especially anytime chains are attached and moving
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STEP 2: CHANGE EXTEND CHAIN DISTANCE
•	Go to SETTINGS at top left of screen
•	Find Extend Chain Distance 
•	Click MASLOW SETTINGS at top of screen
•	Click ADVANCED SETTINGS
•	Find EXTEND CHAIN DISTANCE, set to 1651
•	If using an alternate setup, setting should 
be a multiple of 63.5 MM, approximate 
distance from motor sprocket to where 
ring sled will rest in center of plywood.

STEP 3: CONNECT PORT
•	Go to ACTIONS->PORT
•	Click on the port that you set up 
previously when you set up the 
electronics

•	If you don’t see the correct port, click 
UPDATE LIST

•	Once port is selected, click CONNECT

STEP 1: OPEN GROUND CONTROL TO BEGIN!

STEP 4: INTRODUCTION
•	Read instructions, 
•	Click BEGIN
NOTE: For a variety of reasons you may 
have to run the calibration process more 
than once. If so, there are some steps 
you can skip. This manual will give you 
guidance on which you can skip and 
which you can’t. YOU MAY ONLY SKIP STEPS 
IF IT’S NOT YOUR FIRST TIME CALIBRATING

STEP 5: CHAIN ATTACHMENT METHOD
•	If using the ring that MakerMade shipped 
with your kit, choose TRIANGULAR

•	If using a custom setup, it’s probably still 
TRIANGULAR 

SKIP if you’ve done this before, and haven’t 
changed your setup. This is true for all 
subsequent “Skip” instructions.
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STEP 6: DISTANCE FROM MOTOR TO PLYWOOD
•	Measure approximate distance from center 
of motor shaft to top of plywood, value will 
be fine tuned during calibration

•	CONVERT TO MM! 1 IN = 25.4 MM
•	Click ENTER MEASUREMENT
•	Enter measurement, click DONE
SKIP, if measurement hasn’t changed since 
previous calibration procedures

.01 Degree 
Rotation

1 Degree 
Rotation

5 Degree 
Rotation

STEP 7: SET SPROCKETS VERTICAL
•	The goal is to get one tooth on each motor 
sprocket pointing straight up, 12:00 position

•	Buttons rotate sprocket to specified degree 
•	CW = clockwise) CCW = counter-clockwise
•	Eyeballing is fine, just get it close
•	Click SET ZERO
•	Don’t use AUTOMATIC button 
SKIP, if there have been no “location lost” 
errors in previous procedures or errors with 
chains skipping or tangling

STEP 8: DISTANCE BETWEEN MOTORS
•	Place first link of left chain on left sprocket
•	Click EXTEND
•	Left sprocket will rotate clockwise and feed 
out 100 mm of chain

•	Hold chain to make sure it doesn’t wrap 
around sprocket. 

•	Change value to “1000 mm”
•	Click EXTEND 3 times more, still holding 
onto chain, keeping tension on it

•	Chain should now reach first link on right 
sprocket

•	If not, change 1000 mm value to 10 mm, 
click it until it does

•	Place end of left chain on right sprocket

NOTE: USE EXTEND BUTTON TO FEED OUT CHAIN for the following steps. Draping chains 
over sprocket manually then clicking PULL CHAIN TIGHT & MEASURE will not work.
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STEP 9: SCREEN 5 MEASURING DISTANCE BETWEEN MOTORS
•	If value is still at 1000mm change to 10 MM
•	Click RETRACT until most, but not all slack is gone

CAUTION: during the next step, the chain 
may come off the right sprocket. It can be 
under a lot of tension and if it comes off, 
make sure you’re not within range

A carefully placed small piece of duct tape 
may provide some stability. Just be sure 
the tape doesn’t interfere with  movement 
of the sprocket.

STEP 10: SCREEN 5 MEASURING DISTANCE BETWEEN MOTORS
•	Pay attention to motors and frame during this time, if motors move or frame flexes, make 
adjustments to your frame so this doesn’t happen

•	Click PULL CHAIN TIGHT AND MEASURE. During this step, slack will be taken up and software 
will determine, distance between motors based upon how much chain is fed out. 

•	Chain will slacken up when operation is done

•	Remove chain from frame, set aside until later
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STEP 11: SCREEN 6: PICK CHAIN FEED 
ARRANGEMENT
•	If using default frame, Click CHAIN OFF 
BOTTOM

SKIP- if you’ve done this before

STEP 12: SCREEN 7- REVIEW THE 
MEASUREMENTS
•	For future reference- jot down numbers, 
screenshot, or take a picture

•	If numbers look off, click back button to 
go back and redo steps related to any 
numbers that look off

•	If numbers look good, click LOOKS GOOD

SOME BALLPARK PARAMETERS FOR NUMBERS:
Distance btwn motors = <3048 MM if using 10’ 
top beam, <3568 MM for 12’ top beam
Vertical motor offset = # entered in Step  3
Kinematic type = Triangular
Chain feed type = Bottom
Rotation radius = 140 mm
Chain sag correction value =  varies

STEP 13: SCREEN 8- GENERATE CALIBRATION 
PROCEDURE
•	The machine is doing all the work here, 
•	Take a deep breath, relax for a minute
DON’T SKIP

STEP 14: SCREEN 9- SET SPROCKETS VERTICAL
•	Same procedure as Step 4
•	This time it may work to hit AUTOMATIC
•	If it doesn’t work, don’t panic
•	Re-adjust sprockets with buttons as before
•	When sprockets are in place, click SET ZERO
SKIP only if chains are attached to sled 
because you skipped other steps

STEP 15: SCREEN 10- ENTER ROTATIONAL 
RADIUS ESTIMATE
•	Use numbers given on screen
•	Click ENTER MEASUREMENT and enter 
appropriate value for your kit

•	Click NEXT
SKIP- if you’ve done this before

STEP 16: SCREEN 11- ADJUST CHAIN LENGTHS
•	Place left chain on left sprocket as shown 
•	Click ADJUST LEFT CHAIN while holding on 
to left chain to prevent wrapping

•	Left sprocket will turn counter-clockwise 
and extend chain to a determined length

•	Repeat with right chain
SKIP only if chains are attached to sled 
because you skipped other steps

NEXT YOU’LL ATTACH THE SLED TO THE CHAINS, LEAVE CHAINS EXACTLY WHERE THEY ARE

DO NOT CHANGE THEIR POSITION ON THE SPROCKETS! 
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STEP 17: INSTALL BOLT FOR SLED
BAG #2 pulleys, BAG #4 wood screws
•	Mark center front of top beam, 
about .5” from top edge

•	With .5” drill bit, drill hole in 
marked spot

•	Insert .5” carriage bolt into hole
•	Secure with nut

STEP 18: INSTALL PULLEYS FOR CABLES
BAG #2 pulleys, BAG #4 wood screws
•	Use center beam mark from Step 17
•	Mark 1” to the left, 1” to the right
•	Insert a screw through center of 
each pulley

•	Screw into marked spots

STEP 20: PREPARE STRETCHY CORDS
BAG #2 stretchy cord, zip ties
•	Fold over end of stretchy cord 3”, 
fasten with zip ties

•	Trim ends of zip ties, repeat on all 
cord ends

STEP 19: INSTALL CHAIN HARDWARE
BAG #4 wood screws
•	Mark 8” from end of top beam
•	Insert wood screw in marked spot 
on underside of top beam

•	Leave it protruding about .25”
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STEP 22: ATTACH CHAIN TO MOTOR
BAG #1 small nails
PART #3 Chains
•	DO NOT CHANGE POSITION OF CHAIN ON 
SPROCKET

•	Pick up inside end of chain
•	Insert small nail through circular piece at 
other end of chain

•	Hammer into center of beam 8” from end

STEP 21: ATTACH STRETCHY CORD TO FRAME
Bag#1 S hooks 1. Loop stretchy cord around center pulley

3. Insert S-hook in 
free loop on other 
end of cord

4. Hook temporarily 
to same screw as 
first loop

2. Loop one end of 
stretchy cord to 
screw under beam

STEP 24: CONNECT CHAIN TO STRETCHY CORD
•	Hold chain and sprocket with one hand, grab s-hook from bottom nail with other hand
•	Insert s-hook through center of sprocket

STEP 23: ADD CHAIN TO STATIONARY SPROCKET ON MOTOR
BAG #1 sprockets
•	Grab bottom of “u” of hanging chain, pull up and over nail towards center of frame 
•	Place sprocket in loop of chain, holding onto sprocket and chain for next step
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STEP 27: ADJUSTING THE RING
•	Router should hang vertically
•	If it’s tilted, loosen bolts on L-brackets
•	Move ring up or down on brackets until  
sled rests against plywood without tilting 
away

STEP 25: ATTACH CHAINS TO SLED
•	Carefully hang sled on bolt in top beam
•	This is optional, but very helpful, as it may 
be impossible for one person to balance 
the heavy sled assembly while pulling the 
chains through the carriage mounts

•	A step ladder is also helpful here

THIS IS A GOOD TIME TO MAKE SURE THAT 
YOU’VE LOADED A WORKING PIECE OF 
PLYWOOD ONTO YOU FRAME IF YOU DON’T 
WANT THE TEST CUTS TO BE MADE INTO 
YOUR BACKING PLYWOOD

STEP 26: ATTACH CHAINS TO SLED
•	Grab dangling end of left chain, thread 
through hole in end of carriage mount

•	Insert cottor pin to fasten chain
•	DO NOT USE OPEN LINK AT END OF CHAIN, 
GO BACK TO LAST FULL LINK

•	Repeat with right chain
•	Gently lift sled off bolt and allow weight of 
sled to hang from chains

•	Sled should rest against plywood now

CARRIAGE MOUNT

CHAIN
INSERT COTTER PIN HERE

CARRIAGE MOUNT

COTTER
PINCHAIN
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STEP 28: MOVE SLED TO CENTER
•	Return to Ground Control screen
•	Click MOVE TO CENTER
•	Sled should move to center of plywood
•	Click NEXT

STEP 29: SET HOME POSITION FOR Z-AXIS
•	If Z-Axis is installed, make sure ENABLE 
AUTOMATIC Z-AXIS is turned on

•	Click ADJUST Z-AXIS until router bit just 
touches surface of wood

•	If Z-Axis is not installed, adjust bit depth 
manually

•	Click DEFINE ZERO
SLEDSLED

WORKING SURFACE-  SURFACE TO BE CUT

STEP 30: RUN TEST PATTERN
•	With router bit at zero, turn router on
•	Click CUT TEST PATTERN
•	The Maslow will now cut 5 shapes as 
shown

STAY CLEAR OF MACHINE WHILE PATTERN 
RUNS, IF CHAINS WRAP AROUND SPROCKETS 
OR ANYTHING ELSE HAPPENS, CLICK “STOP 
CUT” THEN TURN ROUTER OFF BEFORE 
TOUCHING CHAINS OR ANY OTHER MOVING 
PART

CUT 1

CUT 3

CUT 2
CUT 5

CUT 4
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STEP 31: ENTER MEASUREMENTS
•	When pattern stops, follow onscreen 
instructions for measuring

•	Measuring distance and entering distance 
between cuts helps software dial in 
machine settings

STEP 32: REVIEW MEASUREMENTS
•	Same as STEP 7, if they look wonky, go back 
and redo steps related to numbers that 
are off

•	If they look good, jot them down
•	Click LOOKS GOOD

CALIBRATION COMPLETE!
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TERMS OF USE
This work is licensed under the 

CREATIVE COMMONS 
Attribution-NonCommercial-NoDerivatives 

4.0 International License

To view a copy of this license
visit http://creativecommons.org/licenses/by-nc-nd/4.0/ 

or send a letter to 
Creative Commons

PO Box 1866
Mountain View, CA 94042

YOU ARE FREE TO:
Share — copy and redistribute the material in any medium or format
The licensor cannot revoke these freedoms as long as you follow the license terms.

UNDER THE FOLLOWING TERMS:
Attribution — You must give appropriate credit, provide a link to the license, and 
indicate if changes were made. You may do so in any reasonable manner, but not in 
any way that suggests the licensor endorses you or your use.

NonCommercial — You may not use the material for commercial purposes.

NoDerivatives — If you remix, transform, or build upon the material, you may not 
distribute the modified material.

No additional restrictions — You may not apply legal terms or technological measures 
that legally restrict others from doing anything the license permits.

NOTICES:
You do not have to comply with the license for elements of the material in the public 
domain or where your use is permitted by an applicable exception or limitation.
No warranties are given. The license may not give you all of the permissions necessary 
for your intended use. For example, other rights such as publicity, privacy, or moral 
rights may limit how you use the material.
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1.6 BUILDING THE FINAL SLED
DESIGN BY THE MASLOW COMMUNITY, PARTICULARLY USERS DLANG AND MADGRIZZLE

TOOLS NEEDED:
Router, .25” router bit
Screwdrivers
Power Drill, .25” drill bit
Sandpaper
Socket wrench, various sizes

5/16 Allen Wrench
Pencil
Safety goggles
Clamps (optional)

CUT LIST:
(1)  18x18” circle
(2) 1x5.5” rectangles
If using MakerMade 
metal brick holders or 
pre-made sled these 
pieces aren’t needed

MATERIALS LIST:
(1)  4x8 Plywood, .75” thick*
(2) Bricks**
(3) Size 10-32 Machine Screws

Precision Level

Difficulty Level

SLED BASE

BRICK
HOLDERS

1X5.5”

18”

18”

*If you have scrap plywood on hand, it’s not neccesary to buy a whole sheet of plywood
**If using MakerMade metal brickholders bricks should be no more than 4.5” wide, you 
can re-use bricks from temporary sled 
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STEP 1 GENERATE G-CODE FOR SLED FILES
•	Download sledfiles.zip at  
Github/MaslowCNC/Mechanics/SVG Files

•	Unzip folder, locate svg file for sled- New 
Sled With Tool Paths.svg

•	Open makercam.com in a browser window
•	Click FILE->OPEN SVG File, select sled file, 
shapes should open up as shown on left

•	This file already has toolpaths set, so click 
CAM->CALCULATE ALL

•	Blue paths will appear, showing path of the 
router, green arrows indicate cut direction

•	Click CAM -> EXPORT GCODE 
•	Click SELECT ALL to select all of the paths
•	Click EXPORT SELECTED TOOLPATHS
•		Save to your desktop as .nc file

STEP 2 LOAD PLYWOOD ONTO MASLOW
•	Hang sled on bolt in center of top beam 
to keep it out of the way

•	Load plywood onto frame
•	Remove sled from bolt and gently bring 
it to rest against plywood

•	A full sheet of plywood is not necessary, 
but may be easier to work with

•	This is a SECOND piece of plywood, in 
addition to the plywood used as backing 
for your frame

STEP 3 OPEN FILE IN GROUND CONTROL
•	Click ACTIONS-> OPEN FILE
•	If using scrap plywood it may be 
necessary to reposition the design

•	Move sled to desired position on 
plywood using arrow keys in top right 
corner of Ground Control

•	Sled will be cut to the left and down 
from beginning sled position

•	When router is in desired position, click 
DEFINE HOME



FINAL SLED ASSEMBLY PG. 3LAST UPDATE 06.11.19 MASLOW DEFAULT FRAME

STEP 6 ATTACH FINAL SLED TO FRAME
•	Hang final sled on bolt in top beam
•	Attach chains to sled, referencing 
instructions in Temporary Sled section if 
needed

•	Remove sled from bolt and gently lay 
against work surface

•	You’re now ready to begin making amazing 
projects!!

STEP 5 ASSEMBLE FINAL SLED
•	Once pieces are cut, turn router off
•	Hang temporary sled on bolt in top beam
•	Remove chains from carriage mounts
•	Remove sled from bolt, set on workbench
•	Remove bolts holding bricks, router, and 
ring kit to temporary sled

•	Transfer everything to final sled, 
referencing instructions in Temporary Sled 
section if needed

•	Sled will slide across the work area more 
smoothly with a rounded edge

•	Use sandpaper to round the edge

STEP 4 CUT THE SLED
•	Turn router on
•	In Ground Control, click green arrow button
•	Router will move through pattern
•	Do not leave Maslow unattended while 
work is in progress

•	If you need to leave for any reason, click 
yellow pause button, turn router off

•	If shapes appear off, click red stop button 
and troubleshoot

•	If you began the cut,  then stopped 
because it was off, when you start again 
you can move your sled to a new area of 
your  plywood, then re-define HOME
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TERMS OF USE
This work is licensed under the 

CREATIVE COMMONS 
Attribution-NonCommercial-NoDerivatives 

4.0 International License

To view a copy of this license
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Creative Commons

PO Box 1866
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YOU ARE FREE TO:
Share — copy and redistribute the material in any medium or format
The licensor cannot revoke these freedoms as long as you follow the license terms.

UNDER THE FOLLOWING TERMS:
Attribution — You must give appropriate credit, provide a link to the license, and 
indicate if changes were made. You may do so in any reasonable manner, but not in 
any way that suggests the licensor endorses you or your use.

NonCommercial — You may not use the material for commercial purposes.

NoDerivatives — If you remix, transform, or build upon the material, you may not 
distribute the modified material.

No additional restrictions — You may not apply legal terms or technological measures 
that legally restrict others from doing anything the license permits.

NOTICES:
You do not have to comply with the license for elements of the material in the public 
domain or where your use is permitted by an applicable exception or limitation.
No warranties are given. The license may not give you all of the permissions necessary 
for your intended use. For example, other rights such as publicity, privacy, or moral 
rights may limit how you use the material.
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